
 

 

Autodesk Softimage Entertainment Creation Suites 
Standard 2012 Release Notes 

This document describes known limitations, issues and fixes in Autodesk Softimage Entertainment 
Creation Suites Standard 2012. It is strongly recommended that you read this document before you 
install this release. For reference, you should save this readme to your hard drive or print a copy. 
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 Click the following links to view the Release Notes for this product: 

• Softimage 2012 Release Notes 

• MotionBuilder 2012 Release Notes 

• Mudbox 2012 Release Notes 

Additional Resources 

For complete instructions about uninstalling and installing Autodesk Entertainment Creation Suites 
Standard 2012, see:  

www.autodesk.com/me‐faq‐2012‐enu 

www.autodesk.com/me‐licensing‐2012‐enu 

For system requirements, see: www.autodesk.com/systemrequirements 

For more resources, see: http://www.autodesk.com/entertainmentcreationsuites‐documentation. 

What’s New 

The following describes the new features and enhancements in the Autodesk® Entertainment Creation 
Suite Standard 2012. The Release Note information for each of the products in this Suite – Softimage, 
MotionBuilder and Mudbox – is also included immediately after.   
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Single‐Step Mudbox Interoperability Workflows 

Iterative workflows between Softimage and Mudbox can now be handled by clicking new options found 
in the application main menus.  In Softimage, you will find a Send to Mudbox menu item that expands to 
allow you to Send as New [Mudbox] Scene, Update Current [Mudbox] Scene, and Add to Current 
[Mudbox] Scene.  In Mudbox, you will find similar options to send to and update Softimage.  These 
workflows are facilitated by FBX 2012 technology, allowing for the exchange of 3D data (meshes, UVs, 
character rigs, etc.) and new features such as Vector Displacement Maps, between Softimage and 
Mudbox.  Vector Displacement Maps are variations on regular displacement maps, allowing surfaces to 
be displaced in any direction, rather than solely along a surface’s normal.  It allows you to use 
displacement mapping to model far more sophisticated shapes with features like overhangs and 
undercuts; i.e. a human ear.  Mudbox can extract Vector Displacement Maps like standard displacement 
maps, and can use them as stamps and stencils for instant sculpting. 

Consistent FCurve Editor 

Animation editors in Autodesk Digital Content Creation packages (Maya, 3ds Max, Softimage, etc.) are 
now more consistent with regards to the way in which function curves are manipulated by the user.  
Working between Autodesk Media & Entertainment packages is now a more consistent experience.  
Tangent types between applications have also been aligned, to allow for a higher fidelity in 
interoperability with FBX technology. 

 Supported Operating Systems 

The 32‐bit version of the Autodesk® Entertainment Creation Suite Standard 2012 software is supported 
by the following operating systems:  

• Microsoft® Windows® XP Professional Service Pack 3 

The 64‐bit version of the Autodesk® Entertainment Creation Suite Standard 2012 software is supported 
by the following operating systems:  

• Microsoft® Windows® 7 Professional 

• Microsoft Windows Vista Business Service Pack 1 

• Microsoft Windows XP x64 Edition Service Pack 2 

Hardware Minimum Requirements 

Note: The system requirements below are for users running several of the following products on the 
same system:  

• Autodesk® 3ds Max® 2012 software  

• Autodesk® Maya® 2012 software  

• Autodesk® MotionBuilder® 2012 software  
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• Autodesk® Mudbox™ 2012 software  

• Autodesk® Softimage® 2012 software  

Note: The system requirements for individual products may differ from those in this document. 

At a minimum, the Autodesk® Entertainment Creation Suite Standard 2012 software requires a system 
with the following hardware:  

• Minimum processor 
o Intel® Core™ two Quad 64‐bit processor  
o Dual‐Core Intel® Xeon® 64‐bit processor  
o Dual‐Core AMD Opteron™ 64‐bit processor  

• Recommended processor 

• Intel® Core™ i7 64‐bit processor  

• Dual Quad‐Core Intel® Xeon® 64‐bit processor  

• Quad‐Core AMD Opteron™ 64‐bit processor  
o 2 GB RAM minimum, 4 GB RAM recommended for the 32‐bit version 
o 4 GB RAM minimum, 8 GB RAM recommended for the 64‐bit version 
o 8 GB free hard drive space is required to install all commercial applications on the same 

system   
o The Education Suite for Entertainment Creation will require a minimum of 10 GB free 

disk space 

• 512 MB hardware‐accelerated OpenGL® 2.0 (and higher) professional graphics cards with 
recommended driver from Autodesk hardware certification pages. Three‐button mouse with 
mouse driver software. 

o DirectX 9.0c application programming interface or higher 

• Three‐button mouse with mouse driver software or certified Wacom® tablet 

• DVD‐ROM drive 

• Ethernet adapter or wireless internet card  

• 1280 x 1024 screen resolution 

Installing the Autodesk Entertainment Creation Suite Standard 

Load your USB key or navigate to the folder where you downloaded the Autodesk® Entertainment 
Creation Suite Standard 2012 executable file and double‐click on the file. 

Note: During the Suite 2012 installation process, you are requested to enter the software serial number 
and product key. Make sure you have the suite serial number and product key handy.  

Note for Linux users: Given that the USB is read‐only and using NTFS file system, these are what need to 
be done in order to make it work: 

1. Install NTFS file system libraries and utilities, if they are not installed.  
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2. Become super user or sudo 
3. mkdir /mnt/myusb 
4. mount ‐r ‐t ntfs /dev/sdb1 /mnt/myusb 
5. cd to /mnt/myusb/Linux‐64/…/ and launch the setup program 

 
Install and activate your products by following the on‐screen installation instructions. 

Microsoft .NET Framework 4.0 requires Windows Imaging Component 

If the Autodesk Installer prompts you to install the Microsoft .NET 4.0 Framework, the .NET 4.0 
Framework installer may prompt you to first install the Windows Imaging Component (WIC). This can 
occur if you do not have the latest Microsoft Windows updates or service packs. You are most likely to 
need WIC if you are running Windows XP SP2 without certain Windows Updates installed. If required, 
the Microsoft WIC installers are available at the following locations: 

• 32‐bit installer 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=8e011506‐6307‐445b‐b950‐
215def45ddd8&displaylang=en 

• 64‐bit installer 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=f64654ac‐6e26‐41d9‐a90a‐
0e7783b864ee 

Uninstalling the Autodesk Entertainment Creation Suite Standard 

Windows XP 

1. Open the Add/Remove Programs dialog in Start > Settings > Control Panel.  
2. Select the program to remove 
3. Click on the Remove button.  
4. Click Yes to confirm the Uninstall.  

Windows Vista and Windows 7 

1. Open Start > Control Panel > Programs > Programs and Features.  
2. Select the program to remove:  
3. Click Uninstall. 
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Known issues and limitations 

Network licensing 

• Suites licenses that are installed on the network can only be checked out by one system at a 
time (refer to the Network Licensing section in the Autodesk Suites Licensing Guide. You can 
view the PDF here.)   

For another user to be able to run any of the products on another machine using the same Suite 
license, all products must be closed on the first system. 

• Cascading issue with Softimage ECS, ESEC, 3ds Max ECSP and Maya ECSP suites. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Autodesk, Backburner, FBX, Maya, MotionBuilder, Mudbox, Softimage, and 3ds Max are registered trademarks or trademarks 
of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and/or other countries. All other brand names, product 
names, or trademarks belong to their respective holders. Autodesk reserves the right to alter product and services offerings, 
and specifications and pricing at any time without notice, and is not responsible for typographical or graphical errors that may 

appear in this document. ©2011 Autodesk, Inc. All rights reserved. 

http://www.autodesk.com/me-licensing-2012-enu


 

 

Autodesk Softimage 2012 Release Notes 

This document describes known limitations, issues and fixes in Autodesk Softimage 2012. It is strongly 
recommended that you read this document before you install this release. For reference, you should 
save this readme to your hard drive or print a copy. 

Contents 

Additional Resources .................................................................................................................................... 1 

What’s New ................................................................................................................................................... 1 

What’s Fixed ................................................................................................................................................ 14 

Additional Resources 

For complete instructions about uninstalling and installing Softimage 2012, see: 
http://www.autodesk.com/softimage‐faq‐2012‐enu 

For hardware qualifications, see: www.autodesk.com/softimage‐hardware  

To report issues with this release, see: www.autodesk.com/softimage‐support  

For more resources, see: www.autodesk.com/softimage‐learningpath  

For the most up‐to‐date release notes for Softimage 2012: www.autodesk.com/softimage‐readme‐
2012‐enu  

What’s New 

UI & General  

 New Web-based Help and user preference for setting online or offline Help locations.  

 Added a STOP button to the playback control panel.  

 The Schematic View now shows links for custom and scripted operators and more hotkey options. 

See also the Schematic View API changes in the SDK.  

 Syflex and Polygonizer plug-ins are now fully translated into Japanese.  

 Added Primitive > Polygon Mesh > Empty for ICE Trees.  

 You can now use 32-bit Quicktime on 64-bit Windows.  

 Added Preferences > Display > Image Clip Thumbnail Size.  

 You can now load progressive JPEG in Windows XP with a limited account or on Windows with UAC 

enabled.  

1 
 

http://www.autodesk.com/softimage-faq-2012-enu
http://www.autodesk.com/softimage-hardware
http://www.autodesk.com/softimage-support
http://www.autodesk.com/softimage-learningpath
http://www.autodesk.com/softimage-readme-2012-enu
http://www.autodesk.com/softimage-readme-2012-enu


 

ICE  

 New Simulation Settings property added to ICE simulated scene elements for controlling sub-frame 

calculations.  

 Lagoa scenes and compounds updated to comply with sub-frame interpolation.  

 Blast compound v.2.1 changed to properly respect end duration.  

 New ICE Nodes:  

 Get Orthogonal Basis  

 Build Array from Set  

 Reference To String  

 New FrameStep  

 New GetSetMedian  

 Create Strand From Curves  

 Modified ICE Nodes:  

 Cache On File  

 New input port that can use a string node to define the path  

 New input port to control the caching mode  

 New Subframe Mode to cache all simulation samples  

 New PPG logic to keep the path visible in all modes  

 Modifier Deformation > Modulate by Null  

 Modifier Deformation > Turbulize Around Value  

 Modifier Deformation > Turbulize Value by Range  

 New ICE Attributes:  

 Intrinsic Attributes  

EdgeID, EdgeToCCWPolygon, EdgeToCWPolygon, EdgeToNextEdgeCCW, 
EdgeToNodes, EdgeToVertices,  
MaterialID, Materials, NodeID, NodeToEdges, NodeToPolygon, NodeToVertex, 
NodeUserNormal,  
PointUserMotions, PolygonalDescription, PolygonID, PolygonToEdges, 
PolygonToNodes, PolygonToVertices,  
Topology, VertexID, VertexIsBorder, VertexIsCorner, VertexToEdges, 
VertexToNodes, VertexToPolygons 

  

2 
 



 

 Custom Attributes Exposed by Compounds  

Display_StrandToMesh_PackedPolygons, 
Display_StrandToMesh_PositionsPerObject 
IsOnSlicePlane, SlicePolyMesh_PlaneNormal, SlicePolyMesh_PlaneOrigin 
StrandToMesh_ExtrusionID, StrandToMesh_IsCapEnd 
StrandToMesh_IsCapStart, StrandToMesh_LastIDFirstExtrusion 
StrandToMesh_NbExtrudedSide, StrandToMesh_NbSections 
StrandToMesh_NbSides, StrandToMesh_PackedPolygons 
StrandToMesh_Polygon_U, StrandToMesh_Polygon_V 
StrandToMesh_SpacingRatio_U, StrandToMesh_SpacingRatio_V 
StrandToMesh_Texture_Projection 

 Topology Task tab in the Preset Manager now has a set of high-level compounds to help 

you quickly get to work with ICE Modeling:  

 Topology/Conditionals/Test Edge Index 
 Topology/Conditionals/Test Index Is Valid 
 Topology/Conditionals/Test Polygon Index 
 Topology/Conditionals/Test PolyNode Index 
 Topology/Conditionals/Test Polygon Inside Null 
 Topology/Conditionals/Test Vertex Index 
 Topology/Copy and Merge/Build Topology Array 
 Topology/Copy and Merge/Copy Default Rendering Attributes 
 Topology/Copy and Merge/Copy Edge Data from Source 
 Topology/Copy and Merge/Copy Material Attributes 
 Topology/Copy and Merge/Copy Polygon Data from Source 
 Topology/Copy and Merge/Copy PolyNode Data from Source 
 Topology/Copy and Merge/Copy Texture Projection from Source 
 Topology/Copy and Merge/Copy Vertex Data from Source 
 Topology/Copy and Merge/Merge Data Sets to Array 
 Topology/Copy and Merge/Merge Edge Data 
 Topology/Copy and Merge/Merge Material ID 
 Topology/Copy and Merge/Merge Polygon Data 
 Topology/Copy and Merge/Merge PolyNode Data 
 Topology/Copy and Merge/Merge Texture Projections 
 Topology/Copy and Merge/Merge Vertex Data 
 Topology/Copy and Merge/Random Material ID per Copy 
 Topology/Copy and Merge/Transform per Copy 
 Topology/Generators/Clone Polygon Mesh 
 Topology/Generators/Create Copies from Polygon Mesh 
 Topology/Generators/Create Extrusion Along Strands 
 Topology/Generators/Merge Polygon Meshes 
 Topology/Getters/Get Closest Edge Index from Null 
 Topology/Getters/Get Copy Index 
 Topology/Getters/Get Edge Index from Test 
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 Topology/Getters/Get Edge Index 
 Topology/Getters/Get Edge is on Edge Loop 
 Topology/Getters/Get Edge Loop 
 Topology/Getters/Get Invalid Index 
 Topology/Getters/Get Material ID 
 Topology/Getters/Get Materials 
 Topology/Getters/Get Polygon Index from Test 
 Topology/Getters/Get Polygon Index 
 Topology/Getters/Get Polygon is on Edge Loop 
 Topology/Getters/Get Polygons Inside Null 
 Topology/Getters/Get PolyNode Index from Test 
 Topology/Getters/Get PolyNode Index 
 Topology/Getters/Get Topology 
 Topology/Getters/Get Vertex Index from Test 
 Topology/Getters/Get Vertex Index 
 Topology/Getters/Get Vertex is on Edge Loop 
 Topology/Getters/Get Vertices Index from Edge 
 Topology/Modifiers/Apply Collapse Edge 
 Topology/Modifiers/Apply Delete Polygon 
 Topology/Modifiers/Apply Delete Vertex 
 Topology/Modifiers/Apply Disconnect Component 
 Topology/Modifiers/Apply Extrude Polygon Along Axis 
 Topology/Modifiers/Apply Invert Polygon 
 Topology/Modifiers/Apply Merge Polygon 
 Topology/Modifiers/Apply Merge Vertices 
 Topology/Modifiers/Apply Slice PolyMesh 
 Topology/Modifiers/Apply Split Edge 
 Topology/Modifiers/Apply Subdivide Locally 
 Topology/Modifiers/Apply Triangulate Polygon 
 Topology/Setters/Set Material ID from Cluster 
 Topology/Setters/Set Material ID 
 Topology/Setters/Set Materials from Library 
 Topology/Setters/Set Materials from Strings 
 Topology/Setters/Set Texture Projection Camera 
 Topology/Setters/Set Texture Projection Planar 
 Topology/Setters/Set Texture Projection Spatial 
 Topology/Setters/Set Topology 
 Topology/Setters/Set Vertex Position on Edge Loop 
 Topology/Shattering/Build Slice Planes 
 Topology/Shattering/Create Basic Shatter from Point Cloud 
 Topology/Shattering/Set Data from Chunk 
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ICE Modeling 

 

New ICE Modeling Nodes 

 Merge Topo (takes any number of topology inputs and will output a merged topology 

command list of all inputs)  

 Merge Topo Array (Merges an array of topologies together)  

 Slice Polygon (includes Delete and Cap options)  

 Apply Slice Polymesh compound (now much faster and can do multiple slices, deletes, 

and caps using array inputs)  

 Extrude Polygon Island (uses a Transform input instead of a vector)  

 Apply Extrude Polygon Along Axis compound (supports cluster, filter, or string inputs to 

define the components to extrude)  

 Create Topo (generates polygon meshes from arrays)  

 Topo Transform  

 Apply Extrusion along Strand  

 Create Strand from Curve compound (generates strands from several curves)  

 Get Topology compound (gets topology similar to what GetPointPosition does)  

 Get Topology (can be used to grab the current topology state of a mesh and clone it with a 

Set Topology)  

 Set Topology  

 Apply Slice Polymesh  

 Add Edge  

 Add Polygon  

 Add Vertex  

 Delete Polygon  

 Delete Vertex  

 Disconnect Component  

 Extrude Polygon  

 Invert Polygon  

 Local Subdivide  

 Merge Disjoint Vertices  

 Merge Polygon  

 Primitive Mesh  
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 Slice Polygon  

 Split Edge  

 Triangulate Polygon  

 For a complete list, see the Topology category in ICE > Tools tab.  

 String > String To Array (for example, used in the "Apply Extrude Along Axis" compound)  

 Builds a 2D array of values given an input string formatted as 
a comma or whitespace separated list of values.  
 The output array type is inferred at connection-time from the 
output port type. The types supported are:  
 
 Type Note  
 siICENodeDataBool   
 siICENodeDataColor4 Input string must contain groups of 4 
float values.  
 siICENodeDataFloat   
 siICENodeDataLong Values can be specified with a range syntax.  
 Example 1 Value: 1,2,3-5,6 Result:1 2 3 4 5 6  
 Example 2 Value: -3-1 2-4 7-5 8-10 -1 Result:-3 -2 -1 0 1 2 3 
4 7 6 5 8 9 10 -1  
 Example 3 Value: -3--1 -5--3 Result:-3 -2 -1 -5 -4 -3  
 siICENodeDataMatrix33 Input string must contain groups of 9 
float values.  
 siICENodeDataMatrix44 Input string must contain groups of 16 
float values.  
 siICENodeDataQuaternion Input string must contain groups of 4 
float values.  
 siICENodeDataVector2 Input string must contain groups of 2 
float values.  
 siICENodeDataVector3 Input string must contain groups of 3 
float values.  
 siICENodeDataVector4 Input string must contain groups of 4 
float values.  
 siICENodeDataRotation Input string must contain groups of 3 
float values.  
 Note: For complex types arrays such as siICENodeDataVector3 or 
siICENodeDataMatrix33, if the number  
 of items in the value string is wrong (for example, missing 
the Z coordinate), the output list will be empty. 

 Basic Math > Clamp  

 Statistics Math > Get Set And  

 New “Topology” attributes (for example, Self.Topology)  
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New Sample Scenes 

 XSI_SAMPLES/Scenes/ICE/Modeling_Basic_Shattering.scn  

 XSI_SAMPLES/Scenes/ICE/Modeling_Columns_From_Strands.scn  

 XSI_SAMPLES/Scenes/ICE/Modeling_Delete_Along_Edge_Loop.scn  

 XSI_SAMPLES/Scenes/ICE/Modeling_Desks.scn" 

"Data/XSI_SAMPLES/Scenes/ICE/Modeling_Desks.scn  

 XSI_SAMPLES/Scenes/ICE/Modeling_Road.scn" 

"Data/XSI_SAMPLES/Scenes/ICE/Modeling_Road.scn  

Syflex on ICE 

 ICE >Task Tab > Syflex  

 New sample scenes  

 Syflex Curve compound  

 Syflex Curve Springs compound  

ICE Flow and Suite Interoperability 

Now supports: 

 Starting in Softimage and sending to Maya  

 3ds Max workflow, starting from 3ds Max  

 Mudbox workflow, including Vector Displacement Maps rendering  

 Linux (for Maya and Mudbox)  

Animation  

 New shadow icons for bone primitives.  

Animation Editor 

 New simplified “Suites” mode (return to Classic from View menu)  

 Updated icons  

 New Isolate F-Curve (View menu and Icon)  

Cache Manager 

 Button to dump icecache header and attributes description into xml format.  
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 Option to reset all transforms before applying caches to objects (useful when cache is in 

global space)  

 Cache ICE sub-sampling attributes (scale with the same factor when loading into the 

mixer)  

Scene Layers 

 Scene layer groups allow you to make a layer the child of another layer, so that you can, 

for example, toggle the visibility from the parent. This replaces the previous 

implementation of layer groups, but old scenes won't be upgraded. A script could be 

written to convert the old layer groups to the new layer structure. Previously, "layer groups" 

were only a way to toggle the check box of all layers of a group at the same time. The new 

implementation works like groups-within-groups so that making a parent visible lets the 

child control its own visibility instead of forcing it on.  

 Layer groups now retain their settings  

 A single click on a row no longer sets current layer  

 User interface changed for Explorer > Layers  

 Only one level of hierarchy is supported (for example, a child layer cannot itself have a 

child)  

 Scene Layer Manager > Check/Uncheck All Menu  
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Texture Editor (TE)  

 UV pinning  

 UV pinning is not used within the TE for operations such as Heal, Collapse, etc. Only 

operations launched from the TE are supported. Commands such as Translate and 

Rotate will not take UV pinning into consideration. Other TE commands related to 

projections such as the ones in Planar and Cubic Subprojections are also not 

considered.  

 New selection mode for selecting pinned UV components. Pinned UV components 

cannot be selected in the TE unless the UV pinning selection mode is on. When turned 

off, UV components are ignored by the selection. UV pinning is supported by Heal, 

Island Heal, Flip, Relax, Match, Cycle, Paste UVW, Transform tools and Move 

Component.  

Weight Editor  

 The weight editor can now be used to edit any weight map or color-at-vertices map, and 

not just envelop weight maps.  

Rendering  

 mental ray 3.9.1.38 integration  

 New User Motion Cluster Property: A new vertex cluster property, named User Motion, 

allows you to control the motion vectors of each vertex of a polymesh object. When the 

User Motion cluster property is applied to an object, the motion blur is no longer computed 

and instead uses the motion data from this property. The simpler way to write on the User 

Motion cluster property is by using ICE.  

 Unified Sampling: The unified sampling is a vast improvement on the previous sampling 

algorithm. You can select the exact number of samples, rather than in increments of 

power-of-four. It also does away with the generic QMC sampler, and uses a new 

computation that doesn't suffer from the same diagonal artifacts as before. This only 

applies to scanline/raytracing however. For rasterizer, the unified sampling controls are 

just mapped into the existing rasterizer settings. Unified Sampling is turned off by default.  

 ICE attributes on meshes can now be accessed in the Render Tree by using the 

texture/weightmap/CAV shaders or the Get Attribute shaders. This is very useful when 
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doing procedural modelling, because you don't have to create clusters in advance for all 

the attributes that you want to access from the Render Tree.  

 Ability to choose the Vertex Color Display property from the Brush properties property 

editor.  

 Control UV Wrapping and UV Smoothing when using ICE attribute as UV: Added a 

mechanism to look for specific constant ICE attributes based on name. If you have a 

vector3 per sample named "MyUV1" doing a set data on "MyUV1_u_wrap" will enable you 

to control the texture wrapping mode used by the projection in the same way you do in the 

texture projection property editor.  

 Versioning support in contextual menus of shader compounds  

 Ability to set default file format for saved Preview image (last used format is remembered 

in a user preference)  

 Added a compression slider for .jpg in Viewport Capture. Also set default JPG quality to 

100%.  

FBX 

 Stereo camera I/O  

 Importing of Vector Displacement Maps from Mudbox  

 Support FBX SDK 2012  

 Added "Import Fbx..." under "File > Import" menu and "Export Fbx..." under "File > Export" 

menu  

 Added scripting commands to create the import/export options  

 Import *.3ds, *.dxf, *obj, *.dae formats  

 Ability to select target .fbx version such as 2010 (Motion Builder compatible), 2011, and 

2012  

 Multiple UVs supported in the FBX Importer/Exporter  

 Supports the import of CgFX materials  

 Supports neutral poses  

 FBX Single-step workflow to Mudbox  

 Materials: Phong, Lambert and Blinn are supported  

 Textures: normal, displacement, vector displacement map, ambient, specular, shiny, 

incandescence, bump, reflectivity and diffuse are supported  

SDK  

New Features 
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 Getting and Setting Size and Position for PPGs: New methods and functions were added 

to PPGLayout in the Object Model and the C++ API to allow for setting and getting the size 

and position of a modal property editor (also known as a PPG). See SetViewSize , 

SetViewPosition, ViewSize, and GetViewPosition in Object Model and C++ API.  

 Undo API: New methods and functions were added to Application in the Object Model and 

the C++ API to allow for opening and closing undo complexes and return true if a 

command is undoing or redoing. See OpenUndo, EndUndo, and IsUndoing in Object 

Model and C++ API.  

 UVProperty Pinning API: New C++ and Object Model API for marking cluster components 

as pinned or unpinned. This API is mainly used by the UVUnfold feature. See UVProperty 

in Object Model and C++ API.  

 Schematic View and Nodes API:  

 New C++ and Object Model API for manipulating the schematic view nodes. See 

Schematic and SchematicNode in Object Model and C++ API.  

 New menu anchor points: siMenuSchematicViewID, siMenuSchematicViewContextID, 

and siMenuSchematicNodeContextID.  

 New SchematicDemo example added to the SDK Examples Workgroup.  

 Scene Layer Manager API:  

 New menu anchor points: siMenuSceneLayerManagerLayersID and 

siMenuSceneLayerManagerContextID.  

 New view attribute selectedlayer. Available for View.GetAttributeValue only.  

 New Events:  

 siOnBeginCommand: Fired when a command is about to be executed. The event can be 

used to abort the command execution, modify the command argument values or 

launch other commands.  

 siOnEndCommand: Fired when a command has been executed. The event can be used 

to access the command return value or output argument values. Contrary to other 

event types, this event is always fired when the current command has been aborted by 

a previous event.  
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 siOnRenderAbort: Fired when a render sequence has been aborted by the user. The 

event can also be sent when a render region job is re-executed as a result of a scene 

change.  

 Added ActionSource support for siFileTypeAction to siOnBeginFileImport and 

siOnEndFileImport events. Now siOnBeginFileExport/siOnEndFileExport and 

siOnBeginFileImport/siOnEndFileImport events support Action and Shape actions.  

 Interactive Tool SDK:  

 New ToolContext class added to the C++ API for building plug-in tools that can be used 

in 3D views.  

 New Math classes CLine and CPlane used by the Tool SDK.  

 Tool Wizard in the Plug-in Manager.  

 New CustomTool example added to the SDK Examples Workgroup.  

 Image Clip and Bitmap Controls:  

 New Image Clip Control in PPGLayout (siControlImageClip): A control that shows an 

Image Clip. A string parameter sets the Image Clip full name. Supported attribute is 

siUIShowClip Set to True to show the thumbnail of the Image Clip control. The control 

toolbar is always displayed, regardless of this attribute value.  

 Static Bitmap control (siControlBitmap): Use siUIFilePath to set the bitmap to show.  

 For an example of both, see PSetUIDemo in the SDK Examples Workgroup.  

 Support for Menu Checkmarks: A new method and two functions where added to 

MenuItem in the Object Model and the C++ API to support menu checkmarks. See 

MenuItem.Checked, MenuItem::IsChecked, and MenuItem::PutChecked in Object Model 

and C++ API.  

 Scripting Shortcuts for Python: New Object Model shortcuts were added to siutils.py to 

facilitate python scripting.  

 Behavior Changes in the SDK:  

 The Layout.CreateView method and the Layout::CreateView function now display the 

name (in the titlebar) of the created view.  

 Scripts can no longer change the number of undo levels permanently. This prevents 

problems that occured when scripts set the number of undo levels to 0 to increase 

performance, and then failed to set it back or terminated abnormally.  
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Object Model Changes 

 New Objects  

 Schematic  

 SchematicNode  

 UVProperty  

 New Methods  

 Application.OpenUndo  

 Application.EndUndo  

 Application.IsUndoing  

 MenuItem.Checked  

 PPGLayout.SetViewSize  

 PPGLayout.SetViewPosition  

 PPGLayout.ViewSize  

 PPGLayout.GetViewPosition  

 New Constants  

 siControlImageClip  

 siControlBitmap  

C++ API Changes 

 New Classes  

 CLine  

 CPlane  

 Schematic  

 SchematicNode  

 ToolContext  

 UVProperty  

 New Functions  

 Application::EndUndo  

 MenuItem::IsChecked  

 Application::IsUndoing  

 Application::OpenUndo  

 PPGLayout::GetViewPosition  

 MenuItem::PutChecked  
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 PPGLayout::SetViewSize  

 PPGLayout::SetViewPosition  

 PPGLayout::ViewSize  

Scripting Command Changes 

 New Commands  

 CreateLayerGroup  

 FBXGetPluginVersion  

 FBXGetSDKVersion  

 PinAllUVComponents  

 PinUVComponents  

 UnpinAllUVComponents  

 UnpinUVComponents  
 

What’s Fixed 

 

These are the fixes that were made during the development of Softimage 2012.  

User Interface 
FELX‐1392  file browsers defaulting to desktop 
FELX‐1198  Weight editor does not refresh on object selection on newly duplicated objects 
FELX‐788  Grow Selection command buttons on custom toolbars doesn't work 
FELX‐605  Regression | Key properties have disapeared from the Profile curves PPG 
FELX‐799  Flipbook doesn't make LZW compressed Tiff files 
ACSO‐25  Animation Editor | Freeze with an animated boolean parameter 
ACSO‐213  Animation Editor | Freeze with an animated boolean parameter 
ACSO‐55  Crash with TortoiseSVN on File Browser 
ACSO‐65  Hiding the Netview toolbar twice through scripting crashes Softimage 
ACSO‐73  A preference for Help Language Japanese is not kept 
ACSO‐105  Draggin some workgroup shaders in the render tree can create a different one 
ACSO‐126  Save scene without RedrawUI kills collapse info of schematic. 
ACSO‐121  A radius of 0.01 is not small enough during paint brushing 
FELX‐1259  Exporer | Operators no more shown under Camera Primitive 

FELX‐991 
Loading a scene not in a project will create an invalid entry in the Recent Scenes 
menu 

FELX‐142  Request for a STOP button in playback 
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Texturing 
FELX‐953  ACSO‐166 ‐ TextureSpaceWidget does not differenciate objects under Models 
FELX‐992  one‐click interop: Softimage should respect TIFF tag to avoid upside down images 
FELX‐1493  UV Pinning undo problem 
ACSO‐64  Multiple Image Properties cannot edit at a time 

Modeling 
ACSO‐22  Crash when transferring in a single step all properties between meshes 

ACSO‐58 
Camera‐view display is corrupt when using Tweak User Normals Tool and Add Edge 
Tool 

Realtime Shaders 

ACSO‐21 
RTS | Annotations with indices (e.g."sas.directionallight[2].color") are not supported 
properly 

ACSO‐74  PPGLayout update problem in 2011 RT shader 
ACSO‐75  siNotInspectable flag update problem in 2011 RT shader 
ACSO‐77  Crash setting camera mode to OpenGL with ultimaper scene 

FELX‐1624 
artifacts when painting vertex colors in realtime shader opengl viewport on meshes 
using custom realtime shaders. 

Reference 
Models   

FELX‐1670 
FELX‐1386 (Expressions on a material lost when you rename a reference model ) not 
fully fixed 

FELX‐1506  Texture map in reference models breaks upon delta creation 

FELX‐1778 
Import Reference Rig and Import REferenced Skinned mesh causes Softimage to 
Crash 

FELX‐1883  Crash persisting scenes 
FELX‐1813  Shaders don't always connect or display properly upon loading scene 

FELX‐1558 
RefModel : Setting resolution and apply constraint child objects will not update 
correctly 

FELX‐1555  RefModel : Expression is not updated when merge scene 

FELX‐1289 
RefModel : Primitive is shifted incorrectly to another layer after applying 
MoveObjectToLayer 

FELX‐1750  Scene Material Corruption with Ref Models ‐ Continued 
FELX‐1702  Disconnected shaders when importing Referenced Model 
FELX‐1686  Expression on Material of a Model is lost after Importing the Model 
FELX‐1651  Scene Corruption in Felix due to Material 

Caching 

FELX‐749 
Cache ‐ Load shape attribute (that reference object in the scene) might be bound to 
the wrong object 
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FELX‐726 
Caching ‐ Load cache doesn't create attributes definitions if the first frame in the 
timeline isn't cached 

FELX‐718 
Cache manager ‐ Read ‐> Apply All should load the cache in the mixer with a scale 
corresponding to the subframe sampling 

FELX‐1365  ICE Cache: Can't read all Lagoa attributes (crash) 
FELX‐1361  Cache Manager: Start End Frames never persisted 
FELX‐1360  Cache Manager: Two caches loaded instead of one 

FBX 
FELX‐1836  FBX warnings shouldn't pop UI when imports occcur at cmd line. 
FELX‐1772  objects sent from 3ds Max do not update 
FELX‐1064  FBX: Node conecting to the reflectivity port of Lambert is missing during export 
FELX‐1024  FBX scriptings commands missing in Help and softimage.wiki.softimage.com 
FELX‐1884  OneClick Maya: Need a Send Entire Scene Option 

FELX‐1842 
Mudbox OneClick: Different updates from Mudbox have the same results in 
Softimage. 

FELX‐316  Ability to import and export stereo camera rigs in FBX plug‐in and ICEFLOW. 

FELX‐1576 
ICEFLOW ‐ Need better warning when sending stuff from XSI to Max without having 
sent nothing from Max first. 

ICE 
FELX‐1142  Corrupt frame numbers with "String File Path Sequence" ICE node 
FELX‐363  SDK ICE: Multi‐Phase Node fails to pull Data 
FELX‐373  ICE 'Cache on File' node: File Name & co parameters not visible when 'Read Cache' 
FELX‐1148  setdata to envelope map problem 
FELX‐1209  ICE | New node to get per element data into a singleton array 
FELX‐1771  Lagoa Crash | Rotating Object that has a child emitter 

FELX‐996 
Lagoa scenes and compounds should be updated to comply with sub‐frame 
interpolation. 

FELX‐377  Lagoa Collision Add Passive Body 
FELX‐364  Lagoa Preset images path is wrong 
FELX‐1323  ICE and lights: "Get data" node the "This." statement doesn't always work. 

FELX‐1283 
ICE | Get Data with self.kine.global works no more on Camera Primitive (compared 
to Softimage 2010) 

FELX‐1112  crash connecting stuff up that shouldn't be 
FELX‐959  ICE | GetSetAnd acts like GetSetOr 

Rendering 
FELX‐1741  Frame token padding behaves differently than documented. Docs are inconsistent. 
FELX‐1358  More than one dash (‐) in a frame set, crashes Softimage 

FELX‐1838 
Saving a rendered frame from the Preview Window without setting a file format 
results in .avi file 

FELX‐1634  Texture projections do not render correctly if named "color" 
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ACSO‐110  
Add the possibility to choose the Vertex Color Display Property from the Brush 
Properties PPG 

FELX‐1649  PPG Logic OnChanged can't be use for Color parameters. 
FELX‐183  Ability to set default fileformat for saved Preview image 
FELX‐1803  Texture Editor: Add UV pinning to TE operations 
FELX‐677  Allow users to set maximum OpenGL texture width to values greater than 2048 
FELX‐1419  Problem loading scene if rendertree Node name and ports are the same 

FELX‐1545 
MR Notification Problem | render region refreshes but does not render is not 
updated 

FELX‐1430  Discrepancy between OGL and Mental ray display of ICE Color Attribute 
FELX‐549  Using Geometry based Area Lights Dampens other lights 
FELX‐792  CRASH Rendering With Irradiance Particles 

FELX‐1239 
Notification filtering through connections is missing scalar ouptut nodes in the 
renderer process callback 

FELX‐1235  Scene render options reports wrong frame range with getValue() 
ACSO‐31  Invalid render region dimensions after being resized interactively 
ACSO‐35  3rd party renderers (e.g. Arnold) crash on Linux 
ACSO‐44  Custom renderer DirtyList isn't cleared properly 
ACSO‐45  AbortEvent breaks 3rd party renderers 
ACSO‐46  libsiutilityshaders shader dependency 

Capture and 
Compositing 
FELX‐190  Default value for preferences.Compositing.MaxCPUThreads to 8 

FELX‐1441 
Missing compression slider for .jpg in Viewport Capture. Also set default JPG quality 
to 100% 

SDK 
FELX‐1719  SDK Doc: OneClick commands not documented 
FELX‐1776  SDK Example: New python TCP server example 
FELX‐1463  SDK: Csharp plugin items stop working after NewScene 

FELX‐1654 
BoxTransformTool example manipulator fails on objects without geometry (lights, 
nulls, ...) 

FELX‐1284 
Crash when opening a Scintilla instance once the PythonWin Debugger has been 
opened 

FELX‐1903  Can't set GUID_PropertyMappingAttribute with the ShaderParamDef API. 
FELX‐562  More Menu anchor Points and Access to View Attributes 
FELX‐1562  Custom Property Wizard is buggy 

FELX‐1596 
When uninstalling Softimage XSIPython removes python from all previous Softimage 
installations 

ACSO‐130  PlotConstrainedTransforms command always popup dialog. 

ACSO‐175 
FCurve.RemoveKeys and FCurve.RemoveKeysAtIndex don't refresh the FCurve 
Editor and the timeline 
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ACSO‐72  SDK: "ClassName" of assigned material does not get expected class. 
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Autodesk MotionBuilder 2012 Release Notes 

This document describes known limitations, issues and fixes in Autodesk MotionBuilder 2012. It is 
strongly recommended that you read this document before you install this release. For reference, you 
should save this readme to your hard drive or print a copy. 

Contents  

Additional Resources .................................................................................................................................... 1 

What’s New ................................................................................................................................................... 1 

What’s Fixed? ................................................................................................................................................ 9 

Feature Limitations and Notes .................................................................................................................... 10 

Additional Resources  

For complete instructions about uninstalling and installing MotionBuilder 2012 see: 
www.autodesk.com/motionbuilder‐faq‐2012‐enu 

For complete documentation and resources, see: www.autodesk.com/motionbuilder2012‐
documentation 

For hardware qualifications, see: www.autodesk.com/MotionBuilder2012‐hardware 

To report issues with this release, see: www.autodesk.com/MotionBuilder2012‐support 

For more resources, see: www.autodesk.com/MotionBuilder2012‐learningpath 

What’s New 

This section briefly describes new features in this release. Please refer to the What’s New in the 
MotionBuilder Help for more detailed descriptions: www.autodesk.com/motionbuilder2012‐
documentation. 

Time Code Property 

A time code property has been added which allows users to associate time code to animation.   

Dark Look and Qt Dockable UI 

MotionBuilder has adopted a dark look UI. As well as the update of many icons, you now have the ability 
to dock and float tool windows.  

New Layouts 

Preset layouts have been updated to the following:  Editing, Scripting, and Preview. 
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Custom Layouts Menu Options 

New options have been added to the Layout menu relating to custom layouts. “Create custom” allows 
you to save any new layout. Enable the “Auto‐update Layout” if you wish to automatically save all 
custom layout modifications.  

New Marker Types 

Additional types have been added to the properties list for markers.  Users can choose to display a 
marker as any of the following marker types: cube, hard or light cross, sphere, capsule, box, bone, circle, 
square, or stick.  

Use Image Sequence 

An “Image Sequence” option has been added to the Video settings pane. 

Visibility Inheritance 

Visibility of a parent node can now be inherited by all children. A property has been added so that it can 
be enabled for each object as needed. New objects created in MotionBuilder 2012 have this property 
set on by default to help keep performance optimal. 

Recording and Storing Vertex Animation/Point Cache 

MotionBuilder now supports the recording and playback of point cache data on models. Point cache can 
boost performance on animation intensive scenes or to transfer animation based on complex constraint 
or physics set‐ups into other applications using FBX. 

A python sample script is provided for recording and playing back point cache animation on characters.  
The script can be found here:  Asset Browser > Scripts > Samples > PointCache > CharacterPointCache.py 

New classes:  

• FBPointCacheManager 

• FBDeformer 

• FBDeformerType 

• FBPoint‐CacheFile 

Added to FBCharacter class:  

• GetSkinModelList( FBModelList& pSkinModelList ) 

Added to FBModel class: 

• NoFrustumCullingRequire()  

• NoFrustumCullingRelease()  

• UseFrustumCulling() 
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Deformers: 

• SkeletonDeformable 

• BlendShapeDeformable 

• ConstrainDeformable 

• PointCacheDeformable 

Nurbs Curves: 

• Nurbs Curves from Maya are now supported in MotionBuilder 

Stereo Camera Rig 

A stereo camera is now available in Motionbuilder. 

New classes: FBCameraStereo, FBCameraStereoType, FBStereoDisplayMode 

Extended classes: FBVideoGrabOptions 

Auto Key Type 

Auto key type behavior has changed. To prevent overshooting or undershooting of fcurves caused by 
the Bezier Auto and User interpolation, a new clamp functionality with ease in and ease out has been 
added.  

Update to HIK 4.5 

The default character solver in MotionBuilder has been changed to HIK 4.5. HIK 3.6 and 4.0 have been 
removed from this version. 

New Characterization Tool 

MotionBuilder has implemented the new HIK Characterization Tool. This tool gives users access to bone 
mapping templates for HIK, Biped, and CAT skeletons, as well as mirroring functions, and instant 
notification when a characterization process is incomplete.  

New Character Controls 

The Character Controls window has also been updated with a new look and some additional controls.    

Vertex Color Display 

Vertex color shading of models is now supported in MotionBuilder.    

The following parameters have been changed in FBGeometry class: 

• VertexInit(int pSize, bool pResize, bool pInitUV = true, bool pInitVertexColor = false) 

• VertexAdd(FBVertex pVertex, FBNormal pNormal, FBUV pUV, FBColorF pVertexColor) 
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The following additions have been made to FBGeometry Class: 

• VertexColorSet(FBColorF pColor, int pIndex=‐1) 

• VertexColorSet(float pRed, float pGreen, float pBlue, float pAlpha, int pIndex=‐1) 

• VertexColorGet(int pIndex=‐1) 

• VertexColorMappingMode  

• VertexColorReferenceMode 

• GetVertexColorsIndexArray(int& pOutArrayCount) 

• GetVertexColorsDirectArray(int& pOutArrayCount) 

A new sample has been created to demonstrate simple geometry creation and vertex color display 
setting, and be found here: Asset Browser > Scripts > Samples > Geometry > VertexColor.py 

Consistent F‐Curve Editor 

The f‐curve editor has been improved to be more consistent with other Autodesk applications.   

Frustum Culling 

Frustum culling will prevent the rendering of anything outside the current camera viewport.  This option 
is turned on by default, but users can press CTRL+Shift+P to toggle the setting on and off. Press Shift+F 
to display the frame and evaluation rates, and the on/off state of the Frustum Culling; all are listed in 
the Evaluation line.  

GPU Skinning 

GPU skinning is now disabled by default on machines with 4 or more cores. Use the CTRL+Shift+D 
shortcut to enable GPU skinning if required. 

Profiling Tools 

Profiling tools are available to allow users to monitor scene performance as well as pinpoint where 
performance cost is highest. 

Profiling is available for:  

• Evaluation: Models, Constraints, Characters, Story Tracks,  

• Devices: Device Input, DevicesNotify, Devices Output 

• Rendering: Renderer, RenderPassGroup(Translucent, TranslucentZSort, Selected, 
OtherPrimitive, SelectiveLighting, etc), ShadeModelPass 

• New classes:  FBProfiler, FBProfileDutyCycle, FBProfileTimeEvent, FBProfileHelper  

Synchronization of Animation with Physics 

A new physics solver property has been added. Enable ForceAnimationSync when the computation of 
the physics takes longer than animation. Note that this means animation will only play when physics is 
live, and animation playback could be slower.    
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Live Video Input Capabilities 

Configure a webcam on your system and launch MotionBuilder. The device appears in the Navigator > 
Videos folder. Click Online and view and record live video directly inside MotionBuilder. 

Up‐Vector Settings Have Been Added to the Path Constraint 

Path constraints now have an option to set an up‐vector. Enable “Follow Path” option in the constraint 
properties to access these options. 

Real‐Time Relation Constraint Filter 

This filter applies a low‐pass filter to incoming live data. 

Audio Link to Take 

You can now assign an audio file to a particular scene take. This option is located in the Audio Settings. 

Displacement Box for Use in Relation Constraint with Devices 

This box has been created to eliminate the dependency on display frame rates when using Relation 
Constraints with Physics.  

New Python Classes 

The following new classes have been exposed in Python: 

• FBOpticalGap 

• FBModelOpticalAdvanced 

• FBOpticalSegment  

• FBRigidBody 

• FBModelMarkerOptical 

• FBPropertyListMarkerSegment  

• FBPropertyListOpticalSegment  

• FBPropertyListOpticalGap 

• FBModelOpticalAdvanced 

• FBPropertyEnumBase 

Exposure of Simple Math Functions in Python 

The following simple math functions have been exposed in Python:   

• Matrix 

• T,R,S to Matrix 

• Matrix to T,R,S 

• Local/Global conversions 

• Vector operations 
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• Quaternion operations 

• Vertex operations 

• Rotation utilities 

• Miscellaneous utilities 

Extended Classes 

The following classes have been extended:   

• FBVector2d 

• FBVector3d 

• FBVector4d 

• FBSVector 

• FBNormal 

• FBVertex 

• FBUV 

• FBColor 

• FBColorAndAlpha 

• FBMatrix. 

New Samples 

The following new samples can be found in the Asset Browser > Scripts > Samples > Math: 

MathUtilities.py (shows the global functions for math) 

Matrix.py (shows extended functions for FBMatrix) 

Vectors.py (shows extended functions for Vectors) 

Hybrid Motion Capture Device 

The plotting requirement after plotting has been removed and users can now record both optical and 
bone data simultaneously. 

New function for FBAnimationNode 

The following new function has been added: 

• WriteGlobalData( double* Data,HFBEvaluateInfo pEvaluateInfo ) 

New Sample Projects 

The following new sample projects have been added.  

• A combination of optical and skeleton device template 

• deviceopticalhybrid 

6 
 



 

• Server to provide test data  

• Opticalhybriddevicetester 

Exposure of TimeWarp  

The functionality of the TimeWarp curve has been exposed in the SDK. 

New class:  FBTimeWarpManager 

The following new sample can be found in the Asset Browser > Scripts > Samples > FCurve > 
TimeWarp.py 

Setting the Initial State of a Checkbox using FBTree 

The class FBTreeNode has a new Boolean attribute: When checked it is used to change the state of 
CheckBoxes created with FBTree. 

GetVertexArrayDuplicationMap added to FBModel Class 

To accelerate real‐time rendering, MotionBuilder will pre‐process the vertex data.  Those control points 
which have multiple attributes, such as normal, UV, etc., will be duplicated in order to have VBO (vertex 
buffer object) alike format.  This function will return the original vertex mapping IDs for those new 
(duplicated) vertexes. 

Distribution of Boost Library 

A new chapter “Custom development with Open Reality & PYFBSDK” has been added to SDK Help. This 
topic focuses on exposing the Open Reality SDK to Python using a third party library called Boost.Python. 
This allows users to add functionality to the ORSDK object and export that to Python.    

A new sample has been added in the ORSDK: pyfbsdk_template. 

New Python Sample for Merging Animation Layers 

Merging animation layers is now exposed through both C++ and Python. It is demonstrated in the new 
Python sample script MergeAnimationLayer.py 

New Python Sample for FBClusterTransactions 

Shows you how to access the cluster and cluster index while using the cluster transactions. 

Python/SDK documentation 

The Qt section has been revised with a detailed step‐by‐step tutorial.  A new chapter "Custom 
development with Open Reality & PYFBSDK" has been added. This topic focuses on exposing the Open 
Reality SDK to Python using a third party library called Boost.Python. 

Changes in Roll Bones Default Settings 

Roll Bone Extraction settings in the Character properties have changed.   
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When no roll bones are present: 

• Arm Roll Mode is set on and all Arm Roll sliders are at 100. 

• Leg Roll Mode is set off and all Leg Roll sliders are at 100. 

When roll bones are present: 

• Arm and Leg Roll Mode is set on and all Roll sliders are at 60. 

Changes When Working with Additive Reference Mode 

To reduce evaluation time and therefore increase frame rate, objects will not automatically be set to 
animatable when loaded or imported in MotionBuilder. This saves the evaluation engine considerable 
time because it is not forced to loop through each object’s transformation fcurves n times per second. A 
substantial savings will be found with scenes containing larger numbers of static meshes.  

Users will see similar behavior and will be able to key objects as usual. Additive rotation, however, will 
require the user to manually set the rotation property to animatable in order to see values larger than 
180. 

New Clip Art Location 

Clip Art files are now located in:  

• C:\Autodesk\MotionBuilder 2012 64bit\Content\ClipArt 

• C:\Autodesk\MotionBuilder 2012 32bit\Content\ClipArt 

Samples folder has been moved inside the ClipArt folder. 

New Characters  

New characters have been added to the ClipArt\Characters folder. 

Configuration Files Relocation 

MotionBuilder configuration files are now written in a folder outside the Program File in order to be 
more compatible with Vista and Windows 7. The new location is: C:\My Documents\MB. 

MB_CONFIG_DIR 

Use MB_CONFIG_DIR environment variable to override the default location of the MotionBuilder 
configuration files. 

MotionBuilder Help and SDK on Autodesk.com 

Starting this release the MotionBuilder Help and SDK Help is being published to the Autodesk.com 
website as browser‐based help systems. By default, MotionBuilder 2012 will not include documentation 
and learning materials with the software installation.  
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Instead, MotionBuilder calls the help and other resources from a web location to provide you with the 
latest documentation available. This shift to publishing directly to the web means we can provide 
regular updates and additions to content in an ongoing manner. This change also significantly reduces 
the footprint of locally installed data to your machine and makes the install and uninstall of 
MotionBuilder quicker.  

View the MotionBuilder Help: www.autodesk.com/motionbuilder2012‐documentation 

View the MotionBuilder SDK Help: www.autodesk.com/motionbuilder‐sdkdoc‐2012‐enu 

What’s Fixed? 

The following list contains bug numbers and corresponding descriptions for issues fixed in this release. 

Bug Number  Description

365168  Broken ORSDK and Python Samples
371719  Constraints folders lose settings on reload
366139  Voice device relation connections not automatically created 
360198  Asset details no longer shows link to textures
351810  Cannot reset destinations in assign sources to destinations 
313677  Import options not remembered
360428  Save selection discards skinning information
360417  Sphere maps cause instability
366553  Keying on reach properties when keying in body part mode 
354748  Changes to Templates folder causes instability
305032  Align control rig has problems with HIK 4.5
375586  Control rig sync problems with HIK 4.5 
304209  Instability caused by setting FBSpreadCell::Style to kFBCellStle View 
310174  Selecting models from ORSDK is too slow when scene has more than 1000 

models 
371035  Property references not saved
376188  Custom Local View is not saved with scene
363335  Saving scenes with many takes causes instability
368194  Expression constraints lose connection to blend shapes after saving 
366131  Merge Append of characters breaks connections with characters in Story
367556  Shader properties are not animated on subtracks with ‘insert current take’
367265  Full screen viewport tiles vertically instead of horizontally 
360934  Hips translation in character definition is not saved
368611   Pop‐up still requires user input for batch processes
361014  Crash with copy/paste of video track
379518  Cannot trim video on a track after a save/open ‐ crash when deleting 
361001  Cannot see video file when trying to open through Story  > Insert Video File
379849  Story Video Track‐ Clips duplicated on Save/Re‐open
378259  AMC import – Dummy bones lost on import
378257  AMC import – Motion not merged on import 
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Bug Number  Description

376527  ASF import – File>Import without AMC not possible
234683  Load Character Animation not supporting plotting for Skeletons 
339057  HIK 4.5 rig effectors flip when manipulated with handles 
378257  AMC import not merging motion on entire hierarchy – only on root 
371311  PythonStartup folder not loading in correct order
342950  Bone size reset after merging .htr data on skeleton
344297  Drop down menu problems on dual monitor
360052  Handles manipulation broken on reload
358797  SaveSelected.py not saving in correct location
374761  Local custom view for properties not saved
377317  Global lighting fog colors reset when layouts change
377487  Macros with namespaces do not merge append correctly 
362904  Extrapolate animation curves is not saving with file
360683  Tabs not working for pop‐ups
360687  Python window always has focus for shortcuts

Feature Limitations and Notes 

The following section describes limitations and other notes about this release.  

Bug Number  Description

359926  Video and audio not synched when recorded with Slave Audio to Video option
359464  Instability can occur when recording video input to a take 
380182  CG Shader is not supported with stereo camera views
380331  Human limits not working with HIK 4.5
381784  Dynamic Lighting shader is not working with Transparency maps 
382027  Override in animation layer has no effect until keyframe is created 
380405  Namespace ‐ Relation macro connection reference
380516  Namespace not maintained on animation layers
380818  FBX Export from Python tools menu creates unstable files when they contain 

new features from 2012 
374138  File > Append breaks relation macros with namespace 
359588  MinSize not working in FBTool
378305  Image sequence does not support layer texture 
380722  Drop down menus in Character Settings are offset using custom layout
378561  DeviceSyncAnimationNodeNotify only triggers if device is selected internally
380995  Cannot add elements to sets with animated visibility
381784  Dynamic lighting shader is not working with transparency maps 
382027  Override in animation layers has no effect until a keyframe is created 
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Notes 

Recording Live Video 

Certain camera drivers seem to cause problems while recording. We found removing the driver resolved 
the issue.   

Video recorded with some cameras will be compressed by default despite setting compression to None 
in MotionBuilder.  This could affect playback on 64 bit since Quicktime is not supported. 

Vertices on a 3d Curve 

Vertices cannot be selected until user selects the first vertex and offsets it slightly, and then all vertices 
appear and can be manipulated normally. 

Cannot Adding Elements to Sets with Animated Visibility 

Scenes will have to be saved and reopened for visibility to be applied to new elements. 

Image Sequence 

Image Sequences are currently not embedded in scene files. 

Path Constraints 

Path constraints are not supported by FBX. Bake the animation onto the constrained object before 
importing into other software. 

Renaming Characters can remove definition 

Character definition could be removed when creating characters if Character is renamed before locking 
initial characterization. 
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Autodesk Mudbox 2012 Release Notes 

Autodesk® Mudbox™ digital sculpting and texture painting software gives modelers and texture artists 
the freedom to create production‐ready 3D digital artwork without worrying about the technical details. 
Designed by professional artists from the game, film, television, and design industries, Mudbox 
combines an intuitive user interface with a powerful creative toolset of stencils and brushes for ultra‐
realistic 3D character modeling, engaging environments, and stylized props.  

This document describes known limitations, issues and fixes in Autodesk Mudbox 2012. It is strongly 
recommended that you read this document before you install this release.  

Contents 

What's New ................................................................................................................................................... 1 

What’s Fixed? ................................................................................................................................................ 2 

Feature Limitations and Notes ...................................................................................................................... 3 

Additional Resources .................................................................................................................................... 5 

 

What's New 

This list provides a summary of new features in this release of Mudbox. Find complete new feature 
information in the "What's New" section of the Mudbox Help at: http://www.autodesk.com/mudbox‐
help‐2012‐enu‐whatsnew 

• UV‐less painting 

• Large texture datasets 

• Paint layer masks and blend modes 

• Editable stencils 

• Single step suites interoperability 

• Performance improvements 

• New brushes and brush options 

• Multiple joints 

• Pose presets 
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What’s Fixed? 

The following table contains bug numbers and corresponding descriptions for issues fixed in this release. 
 

Bug Number  Description

301892  Import As Layer should create layer with the name of the imported mesh.

305342 
Texture extraction when using limit surface sometimes wrong, because of 
valence. 

309936  Deselecting mesh in Object List does not deselect it in 3D View. 
312581  Subdividing a mesh where multiple polys share single edge crashes Mudbox.
314428  Slider interaction slow when 2k 32‐bit stamp image loaded. 
320264  Lock on layers is lost when file is saved and reopened.

324439 
When painting, wireframe disappears until the 3D View is refreshed (by 
rotating, for example). 

336327  Can’t set topological axis with FBX file. Workaround by subdividing once.
343947  Blur and Clone tools don't work properly with blend modes. 
344786  Falloffs don't update in Paint Tools.
346565  Crash selecting selection set in Object List after extracting normal map.

351055 
Vector Displacement Map should be added in Map extraction results dialog 
box. 

354109  Joints stop displaying but are still there when Create Joint is unsuccessful.

359643 
Transfer Details crashes Mudbox when the Subdivide target is Highest source 
level. 

363155  Deselecting objects in the Object List sometimes doesn't work. 

363203 
Painting is not correct  when using the Projection brush with stencils derived 
from a 16bit tiff,  32bit tiff, 16bit exr and 32bit exr. 

363273 
“Opacity” column in the Layers window has been renamed to "Strength". This is 
meant to prevent confusion with opacity paint layers. 

363294  Fix UV View drawing performance and quality.
364064  Black spots in extracted displacement map, with large distance of 24. 

364660 
Placement and orientation of stamps is not along brush direction on dense 
meshes with more than 2.5k base level. 

364665 

Linux: If you use the "Send to Mudbox..." option in Maya when Mudbox is 
closed, the Mudbox splash screen appears briefly, then Mudbox crashes and an 
FBX file is created in the /usr/tmp folder.  
On Linux, you must have Mudbox already open for the "Send to Mudbox..." 
option in Maya to work. 

364858 
Extracted map is empty when the target mesh is n‐sided, source is an upper 
subdivision level, and subdivision method is selected. 

364901 

Set the Max Texture Size preference to be greater than the resolution being 
imported if the image is greater than 4096x4096. This must be done before 
importing the image otherwise painting will be slow and areas of the texture 
will be missing. 

366522  Duplicate paint layer does not keep blend mode, opacity, visibility, lock status.
366522  Duplicate paint layer should remember blend mode, opacity, visibility, lock.
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366733 
Blurring transparent areas of a bump map (or even a fully transparent bump 
map) will produce dark grey semi‐opaque pixels on the map. 

366949 
The Color Chooser and Eyedropper select only 8 bit values which is not 
accurate. (Now selects 16 bit values.) 

368386  Incorrect display when undo posing joints with mirror joints. 
369079  Enable Direction property for Contrast, Fill, Scrape, and Wax. 
371393  Paint is lost on inactive Materials.
301204  Stencil is offset from brush stroke after stencil is scaled. 
336123  FBX: Negatively scaled objects are ignored on import.
358608  Freeze brush and undo not working for multiple objects. 

362454 
Rebuild Subdivision Levels does not unsubdivide back to original mesh with n‐
sided faces. 

362806 
Rebuilding subdivision levels fails on certain objects that have been subdivided 
in other programs and imported into Mudbox. 

364254  Create New Paint Layer doesn't remember Size property. 
364280  Rebuild Subdivision Levels changes the Vertex IDs of the high‐level mesh.
366513  Create Paint Layers with UV tiles gets wrong result, causes black layer.
367856  Wrong extraction of Transfer Paint Layer when there are two targets. 

  Hidden geometry becomes visible when stepping down a subdivision level.
  Paint undo is currently limited to 19 actions. (Changed to 50.) 
  Brush Size/Strength doesn't update in Properties if hotkey is used. 

Feature Limitations and Notes 

This section lists known limitations and workarounds for Mudbox 2012.  
Please report any additional issues using the online bug reporting form at:  
www.autodesk.com/mudbox‐bugreport or from the Help > Report a Problem menu item in Mudbox. 

Bug Number  Description

355804 
Creating a joint may be difficult if the mesh has a lot of detail.  Workaround: 
Create the joint at a lower subdivision level. 

355918 
Installation: Error that says the product key may be invalid and to re‐enter it. 
Workaround: Click OK on this dialog, click Next button again, and if product key 
is valid the installation continues. 

357041 

Mudbox on Linux does not get pressure events from Wacom tablets with 
Fedora 12/Redhat 6, QT 4.5. You can find more details in the bug report here:  
 
https://bugzilla.redhat.com/show_bug.cgi?id=569132 
   
There is a patch for Qt here:  
http://koji.fedoraproject.org/koji/buildinfo?buildID=160252 
 

358312 
Files that include 16 bit TIF maps will show errors with "Send to Maya..." 
operation. 

360224 
Mudbox crashes if the extraction map output file name contains %S in string 
(for example: AO_(%S).bmp). 

361565  Tumbling in the 3D View while importing a paint layer may cause Mudbox to 
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Bug Number  Description

exit unexpectedly.  Workaround: Wait until the load is complete. 

362133 
Creating a joint with Topology Weights doesn't work properly with non‐4‐sided 
meshes. Workaround: Use alternative Weights method. 

362857 

If the level of the source model is not the current level when extracting a map, 
the detail of lower sculpt layers will be missing.  Workaround: Ensure you 
display the required subdivision level before extracting the map, or select the 
current level in the Extract Texture Maps window to get the correct result. 

363366 
Transfer paint layer works incorrectly if target and source have overlapping 
UVs. 

366007 

The Transfer Details function works best on objects that are the same size, or 
larger, than the default Mudbox meshes. If the transfer produces artifacts on 
the target mesh, try scaling up the source and target meshes to the same size 
as the default head mesh. 

374126 
When using a non US‐English standard keyboard, some of the hotkeys may not 
work. Workaround: Set your IME to "English ‐ United States" while using 
Mudbox. For more information see your operating system documentation. 

376624 

Installation (Windows). Mudbox does not start from Japanese/multi‐byte path. 
If you install Mudbox to a custom location containing Japanese/multi‐byte 
characters and then attempt to open Mudbox, Windows returns an error. 
Workaround:  Do not install Mudbox to a custom location containing 
Japanese/multi‐byte characters. 

377770 
Send to 3ds Max: Changing units between Max and Mudbox causes 
unpredictable results. 

381451 

Due to recent changes made to the common shader, scenes that contain 
models using the older default material from 2010 are no longer supported in 
2012. Possible side effects: shadows may not display correctly and posing will 
not work. Workaround: Assign the 2012 materials. 

381496 

When painting or sculpting with symmetry ON, sometimes the result will not 
appear on the opposite side. Verify that you have the "Falloff based on Facing 
Angle" checkbox turned off. This is a known limitation with a combination of 
symmetry with the "Falloff based on Facing Angle" option. 

 

• To run Mudbox 2012 you must have a processor which is SSE3 compliant. Mudbox uses SSE3‐
specific code, which does not allow Mudbox to run on hardware which is SSE2 or previous.  

• Sculpting with the Stamp Spacing property turned on will cause the brush stamp to be offset to the 
cursor location when using a Wacom Cintiq or a Wacom tablet when the pen setting is set to Mouse 
mode. To correct this, add the environment variable "MUDBOX_USE_LOWRES_TABLET_DATA".  

• With ATi graphics cards, if you are seeing texture painting corruption such as painting black and 
artifacts, adding the environment variable "MUDBOX_PAINT_CONTEXT_FLUSH" may fix the 
problem. 

• Some users may be seeing incorrect GPU RAM reporting causing many warnings to pop up every 
time they create, merge, or change the visibility of layers. The environment variable 
"MUDBOX_FORCE_GPU_RAM" (on Windows only) lets you override the amount of GPU memory in 
megabytes that Mudbox sees. If you have an Nvidia Quadro 5600 and it reports 1 MB of GPU RAM 
(the hardware has 1.5GB), set the variable to 1536 (which is 1.5 * 1024) for that card. Values which 
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are not numbers will be ignored, and values will be clamped to the range 256 to 4096. 
Note: For more information on these environment variables, see the Environment Variables topic in 
the Mudbox Help.  

• On Mac OS X, release configurations may not build correctly. User must set the Active Architecture 
to x86_64 in Xcode.  
To do this:  
1. Open example project using Xcode.  
2. In menu bar, select Project > Edit Project Settings.  
3. Select the Build tab.  
4. Under Architectures in the Setting window, make sure the Architectures value is set to 64‐bit 
Intel.  
5. Close window and build using the Release configuration.  
PtexImporter example requires PtexExtractor example to be built and copied into PtexImporter's 
build directory for linking.  
To build Turntable example, install Qt and run moc on the example header files. See readme in 
example. 

• If you experience any difficulty launching the Mudbox Help using Internet Explorer, use an 
alternative browser such as Firefox, or download and install the Help locally from 
http://www.autodesk.com/mudbox‐helpdownload‐enu 

• If you previously installed any beta version (including Release Candidate versions) of Autodesk 
Mudbox 2012, you must uninstall and delete all system folders pertaining to the pre‐release 
versions before you can install the commercial version.  

Additional Resources 

For complete installation and licensing instructions refer to the Installation Overview and FAQ and the 
Licensing Guide. Access these guides from the Installation Help link of the Mudbox installer or find them 
here:  

http://www.autodesk.com/mudbox‐faq‐2012‐enu 

http://www.autodesk.com/me‐licensing‐2012‐enu 

Find new feature information in the "What's New" section of the Mudbox Help at:  
http://www.autodesk.com/mudbox‐help‐2012‐enu‐whatsnew 

Find learning resources for Mudbox at:  
http://www.autodesk.com/mudbox‐learningpath 

 
Watch videos to learn how to use Mudbox at: 

http://www.autodesk.com/mudbox‐trainingvideos 
Find support resources at: 

http://www.autodesk.com/mudbox‐support 
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For the latest list of certified hardware to run Mudbox 2012, including graphics cards, refer to the 
Mudbox 2012 certification chart located at: 

www.autodesk.com/mudbox‐hardware 
 
Find the Mudbox 2012 minimum system requirements at: 

http://www.autodesk.com/mudbox‐systemreq‐2012‐enu 
 
Find documentation and examples for the Mudbox SDK with your installed version of Mudbox here: 
\Mudbox2012 \SDK\doc or online here: 

http://www.autodesk.com/mudbox‐sdkdoc‐2012‐enu 
 
 
Customer Involvement Program (CIP) 
The first time you start Mudbox, the Customer Involvement Program dialog box appears. If you choose 
to participate in the Customer Involvement Program, Mudbox will automatically send Autodesk 
information about system configuration, what features you use most, any problems that you encounter, 
and other information helpful to the future direction of the product. For further information, see 
http://www.autodesk.com/cip. 
 
Customer Error Reports (CERs) 
We are able to improve the stability of Mudbox largely because of the Customer Error Reports (CERs) 
that users of our products submit. We thank you for taking the time to fill out these reports and ask that 
you include as much information as possible about what actions you were performing at the time the 
error occurred. These details raise the value of the report immensely and are very much appreciated by 
the Autodesk Mudbox Engineering team.  

For further information about CERs refer to http://www.autodesk.com/cer.  

 

Autodesk, Backburner, FBX, Maya, MotionBuilder, Mudbox, Softimage, and 3ds Max are registered trademarks or trademarks 
of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and/or other countries. All other brand names, product 
names, or trademarks belong to their respective holders. Autodesk reserves the right to alter product and services offerings, 
and specifications and pricing at any time without notice, and is not responsible for typographical or graphical errors that may 

appear in this document. 

©2011 Autodesk, Inc. All rights reserved. 
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